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Update 1 — July 2022 (Build 24.1.175)

U.S. Payroll Tax Tables—July 2022 
Payroll tax tables have changed for  the following jurisdiction:

 l Idaho  

Canadian Payroll Tax Tables—July 2022
This section highlights federal and  provincial tax changes.

Federal Payroll Tax Changes

No federal payroll tax changes are included in this update.

Provincial and Territorial Payroll Tax Changes

The following provinces and territories mandated payroll tax changes, effective July 1, 2022: 

 l British Columbia

 l New Brunswick

For detailed information on personal amounts, see the TD1 form for each province or territory.

Fixes in Both Editions
Version 24.1 includes the following software fixes in both the U.S. and Canadian editions:

 l The year 2022 correctly appears in title bar of version 24.1 installation windows. 

 l You can post service contracts and routes when the posting period is set based on the transaction date. 

 l Sage Estimating version 21.1 now integrates properly with Sage 100 Contractor version 24.1. 

 l If you unlock an Accounts Payable invoice for editing and then the status or paid amount of the invoice 
changes, Sage 100 Contractor prevents you from saving the invoice. (Saving the invoice in this 
condition would trigger an audit error.) 

 l Duplicate general ledger links in the database no longer cause an error when you upgrade a company. 
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Fixes for the U.S. Edition
The following issue was fixed specifically for the U.S. Edition of Sage 100 Contractor:

 l    You can print 5-4-2 State Tax and 5-1-1 Certified Payroll reports for Alaska without triggering an error. 
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Compatibility with Sage Estimating

Important! Sage 100 Contractor version 24.1 is not compatible with Sage Estimating version 20.1 and 
earlier versions. If you integrate Sage 100 Contractor with Sage Estimating, do not install Sage 100 
Contractor version 24.1 until you install Sage Estimating version 21.1.
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U.S. Payroll Tax Tables—May 2022

Payroll tax tables have changed for  the following jurisdictions:

 l Alabama  

 l Illinois  

 l Maryland (state and county tables)  

 l Utah (effective May 1)  
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Enhancements in Version 24.1

This section describes the new features and enhancements you will find in  version 24.1.

We've been listening to you!
Sage thanks you for your product ideas! In version 24.1, we have incorporated the following top-ranked 
suggestions from the Sage Ideas site. Later sections in the Release Notes describe changes that require more 
detailed explanation.

 l General Ledger

 l You can assign source ledger security for General Ledger so that users can see in the 1-3 
Journal Transactions window only transactions from sources they have permission to view. For 
example, you can restrict a security group to view only general ledger transactions created for AP 
invoices, AP checks, AP credit cards, and so on. 

For more information, see Assigning GL Transaction Source Security, later in this document.

Thank you for this suggestion, Eryn D.

 l Accounts Receivable

 l When setting up a new job for an existing client, you don't have to reenter all the client's contact 
information manually or copy and paste them from the client's Contact grid. You can now import 
contacts from their client record into the job record.   

For more details about these changes, see Importing client contacts into a job, later in this 
document.

Thank you for this suggestion, Lisa S., and for suggesting additional improvements,  Charlene D., 
Sherry D., and Danielle D.

 l Accounts Payable

 l We've made it easier for you to edit paid Accounts Payable invoices while preserving your audit 
trail.  

If you need to change the job, ledger account, cost code, or description after you've paid an 
invoice, you can now edit the invoice without having to void and then recreate the invoice and 
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payment. Sage 100 Contractor voids the original GL transaction and associated job costs, and 
creates a new transaction and job costs for the edited invoice.  

Thank you for your suggestions, Alejandro M., Kayla, Joanna W., and Teresa M.      

 l Payroll

 l Turning on a new Payroll Admin security authorization enables you to hide certain personal 
records from users who don't have that authorization. Then, you select a new Require Payroll 
Admin Access option in individual employee records to restrict sensitive payroll records in Payroll 
and other ledgers.

For more information, see Assigning Payroll Admin security, later in this guide.

Thank you for your suggestions, Nancy K. and Richie W. 

 l You can use a new Nickname field in employee records to identify employees by a short name or 
their preferred name.

Thank you for your suggestion, Jackie B.      

 l In the 5-5-1 Daily Payroll Entry window, when you import a Daily Field Report, pay rates and 
Workers Comp codes are included in the report for each employee. 

Thank you for your suggestion, Eric T.      

 l Pay stubs now show account distributions for employees paid by direct deposit who allocate their 
pay among several personal accounts. 

For more information about this and related changes, see Account distributions on direct deposit 
pay stubs, later in this document.

Thank you for this suggestion, Donna P.

 l The 5-2-1 Employees window includes a new 8 – Retired status. 

Thank you for this suggestion, Shannon H.

 l In the U.S. Edition, there is a new option to calculate non-resident state tax withholding and 
attribute it to the home state of employees who have a non-resident state tax withholding 
calculation. Tax on the non-resident wages is calculated as if the employee worked in their home 
state. 

In the employee record, inactivate the non-resident state income tax calculation (change the 
Active status to No or a blank).

In the 5-2-3 Compute Payroll window, from the new Options menu, select Use Reciprocal State 
Income Tax Withholding Rules.
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The final computation will calculate state tax withholding for wages the employee earned in the 
non-resident state and attribute it to their home state.

Thank you for this suggestion, Gwyl W.

 l In the 5-6-6 Simple Time Entry window, you can specify how many days after the end of a pay 
period users can submit time using the Mobile Time app. Use the new Allow time entry up to [x] 
days(s) after the end of a payroll period setting on the Company Settings tab to specify the 
number of days. 

Thank you to our earliest adopters of the Sage 100 Contractor Time mobile app, Sharon J. and 
Jeremiah F., for this suggestion

 l Project Management

 l The 6-6-1 Purchase Orders window has a new Set PO Vendor/JobPhase Editing Rules option. If 
you sign in with company administrator privileges, you can select options allowing users to edit 
the vendor and the job and phase on existing purchase orders. 

Allowing users to edit purchase orders means that if an original purchase order has the wrong 
vendor or if the vendor doesn't have the product stocked, you or another user can simply change 
the vendor, rather than having to create a new purchase order.

For more information, see Setting purchase order editing rules, later in this document.

Thank you for this suggestion, Deborah T. and Tanya L.

 l We added date selection criteria to the 6-1 Job Reports window, so now you can print the Job 
Cost Summary Report by date.  For example, you could print the report by a specific  date to 
capture job costs for invoicing. (

Thank you for this suggestion, Shana P. 

 l Utilities

 l You can use the new 7-7 User Activity report to fortify your internal controls and to facilitate 
forensic audits. Based on the history you keep for your company (typically six months), this report 
is a comprehensive list of a selected user's activity in the accounting and payroll areas of the 
program for a specified range of dates. 

For example, if your company is concerned about fraud, you can quickly and easily get a report of 
all the entries an employee made in the last days of their employment without your having to build 
search queries for multiple windows. 

Note: The report is available only if you sign in to Sage 100 Contractor with administrator 
credentials.
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For more information, see About the 7-7 User Activity Report in the Sage 100 Contractor help.

Thank you for your suggestions, Joe M., Tylene V., Steve S., Jeff R., Melissa V., Garry M., and 
Ryan B. (Yes, we do read all of your suggestions! Keep them coming, please!)

 l U.S. banks now require a Standard Entry Class Code in the headers of ACH files. 

On the Vendor ACH Payment Setup tab of the 7-1 Company Information window, we've added a 
new Standard Entry Class Code option. 

Specify one of the following For 'Standard Entry Class Code' in the file header record, use options 
for ACH files:

 l PPD. Select the PPD (Prearranged Payment and Deposit) option if most of your ACH 
payments are to individuals.

 l CCD. Select CCD (Corporate Credit or Debit) if most of your ACH payments are to other 
companies or to pay taxes.

Thank you for this suggestion, Lana J.

 l Miscellaneous enhancements

 l On the 11-3 Dispatch Board, you can set a new option to distinguish invoiced orders from other 
work orders, by making invoiced orders transparent while work orders that are not yet invoiced 
stand out clearly.

For more information, see "Easily identify invoiced work orders on the Dispatch Board" (page 18), 
later in these Release Notes.

Thank you for this suggestion, Christina L.

 l We added an Important Notes option to data entry windows  that have a notes ( ) button in the 
header section of the window.

You can add important information that you want to draw to users' attention when they open a 
particular record. You enter this information in a new Important section at the top of the Notes 
window. The next time you or another user opens the record, Sage 100 Contractor displays the 
important information in a pop-up window. 

Example: If there are special conditions attached to an invoice, you can add an important note to 
the invoice to make sure that you or other users processing the invoice do not overlook that 
condition.

If you don't want to see important notes as confirmation immediately after saving them, you can 
suppress the display by selecting Options > Hide Important Notes On Save in the Notes window.

Thank you for this suggestion, Charlotte C.
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 l If a printing window includes system reports that should not be available to most users, company 
administrators can hide them. Then, new staff and other users who are not familiar with a 
particular window can easily tell which reports they should use.

To hide system reports, you click a new [Show/Hide System Reports] button in the printing 
window. Sage 100 Contractor displays a new window where you can select reports to hide. 
Printing windows notify users that one or more system reports are hidden.

Thank you for this suggestion, Ryan B.

 l When you print customer-facing documents, you can use the new Save And Print menu option or 
toolbar button (  ) to save changes to the record you're working with, and then display 
information from that record in the report-printing window. 

Thank you for this suggestion, Nathan T.

 l Sage 100 Contractor now warns you if you try to save or post a transaction to a job that has 
Completed status.

Thank you for this suggestion, Gary P. and Liz T.

 l Depending on your scanner and how it is set up (including your driver and connection), you may 
be able to scan documents directly to Sage 100 Contractor without having to save them to 
another location first.  

Note: Not all scanners work with this feature.

For more information, see Attaching scanned documents directly to records.

Account distributions on direct deposit pay stubs
Many employees distribute their pay to more than one personal account—for example, 50% to a checking 
account and 50% to a holiday savings account. You set up these distributions to up to four accounts for 
employees on direct deposit in the 5-2-1 Employees window. The distributions to these accounts are 
processed when you run a final compute and they are printed on the pay stubs.

After you run a final compute, you can view the distributions that will appear on a direct deposit pay stub by 
selecting the new Direct Deposit Net Distribution option in the  5-2-2 Payroll Records window. Selecting this 
option opens a new Direct Deposit Net Pay Distribution window that lists, for each account number, the routing 
number, rate type, and deposit amount. 

In the U.S. Edition, it also displays the account type. If you turned on the Database Security Encryption option 
for your company in the 7-1 Company Information window, all but the last four digits of account numbers are 
hidden (the program displays Xs in their place).
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Note: When you upgrade to version 24.1, if you have not yet created a deposit file for final-computed 
payroll, Sage 100 Contractor includes the distribution accounts on the direct deposit stubs when you 
create the direct deposit file.

 

Assigning GL Transaction Source Security
You can assign transaction source security for General Ledger so that users can see in the 1-3 Journal 
Transactions window only transactions from sources they have permission to view. 

For example, if you want to ensure that accounts payable clerks cannot view transactions from Payroll, when 
you set up their security group, specify each type of source transaction that users in this group can view in 
General Ledger.

To assign GL Transaction Source Security to a security group:

 1. Open 7-2-1 Security Groups.

 2. Set up the security group as usual, or select an existing security group.

 3. In the GL Transaction Source Security cell, press F5 or click the lookup  button.

Sage 100 Contractor displays the Select Transaction Sources Allowed for Group window.

 4. In the Select Transaction Sources Allowed for Group window, select each transaction source that 
employees in this group can view in General Ledger.

Tip: If menu-level security is applied in the program for the selected security group, you can save time 
by clicking the [Use Menu Security] button to select the transaction sources automatically based on the 
menu-level security settings for that group.

 5. Click [OK] to return to the 7-2-1 Security Groups window.

 6. Click File > Save. 

Assigning Payroll Admin security
Turning on the new Payroll Admin security enables you to hide sensitive information about certain employees 
from users who should not have access to it (for example, to hide executive salary information from users 
entering hourly payroll).

Turning on Payroll Admin security involves the following steps:
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 1. Granting Payroll Admin access to at least one user.

Note: This security access is separate from Company Admin access.

 2. Selecting the new Require Payroll Admin Access option in at last one employee record. 

After you turn on Payroll Admin security, all users need Payroll Admin access to view any but the most basic 
payroll information for employees marked with the Require Payroll Admin Access option, including information 
in the following records and reports:

 l 5-2-1 Employees

 l 5-2-2 Payroll Records

 l 5-5-1 Daily Payroll Entry, including time imported from Daily Field Reports and third-party programs.

 l 5-1 Payroll Reports, 5-5-2 Daily Job Report, 5-5-3 Daily Labor Reports, including Aatrix reports, payroll 
queries, alerts, and API requests. (Printed by employees without Payroll Admin access, reports do not 
include information about employees that require this security.)

Users also need Payroll Admin access to perform the following functions for employees with this security 
requirement:

 l Updating paygroup rates and benefits for all employees in 5-2-1 Employees

 l Updating ACA information for all employees in 5-2-1 Employees

 l Creating records for salaried employee in the 5-2-2 Payroll Records window

 l Computing payroll in 5-2-3 Compute Payroll

 l Creating checks in 5-2-4 Payroll Checks

 l Creating a direct deposit file in 5-2-5 Direct Deposit File Manager

 l Posting payroll using 5-2-6 Post Payroll to GL

 l Printing 5-2-7 Compensation Slips

 l Printing 5-2-8 Timecard Journals

 l Updating default rates and maximums for calculations in 5-3-1 Payroll Calculations

 l Creating timecards from 5-5-1 Daily Payroll records

 l Performing an audit or repair in 5-3-7 Payroll Audit

 l Opening the 5-3-9 HR Forms window
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 l Opening the 5-4-1 Federal Forms and 5-4-2 State Forms windows

 l Opening the 7-7 User Activity Report (also needs company administrator access)

If Aatrix reports and payroll audit reports are missing sensitive information when a user without Payroll Admin 
access generates them, Sage 100 Contractor warns the user that the reports are incomplete.

Tip: Sage suggests you use Payroll Admin security together with GL Transaction Source Security to 
prevent users who are not payroll administrators from using General Ledger to view wage information. 

To assign Payroll Admin security:

 1. Open the 7-2-2 User List window, and then:

 a. In the grid, for each employee that requires privileged access to sensitive information, double-
click in the Payroll Admin column, and then type Yes.

Note: Granting Payroll Admin security to any employee turns on Payroll Admin security for the 
company.

 b. Close the window.

 2. Open the  5-2-1 Employees window, and then:

 a. For employees whose salary and other information is especially sensitive (such as executives or 
owners), use the data control to select the employee record.

 b. On the General Information tab, select the Require Payroll Admin Access check box.

 c. Close the window.

 

Importing client contacts into a job
When setting up a new job for an existing client, you don't have to re-enter all the client's contact information 
manually. You can now import contacts from their client record into the job record.   

To import a contact list from a client record:

 1. In a 3-5 Jobs (Accounts Receivable) record, click the new [Import Client Contacts] button above the 
Contacts grid. 

Sage 100 Contractor displays a list of the client's contacts in a separate window.

 2. In the Select Client Contacts to Import window, select the contacts you want to import. You can:
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 l Select particular contacts from the list. If the client has many contacts, select only the contacts that 
are responsible for the job.

 l Click [Select All], if you want to import all the client's contacts.

 3. Click [OK].

Tip: If you need to edit the imported contact information for the job, you can use the new Contact 
Manager in the 3-6 Receivable Clients window. From the Options menu in 3-6 Receivable Clients, select 
Manage Contacts. 

This window is similar to the 7-4 Contact Manager, with some advantages. It lists all the contacts from all 
the jobs assigned to the client, as well as the client's own contacts. If you need to update a contact, you 
can find all the instances of them and correct them together.

Setting rules for editing purchase orders
If you have company Administrator rights, you can set rules for editing the vendor or the job on existing 
purchase orders. 

To open the new Rules for Editing PO Vendors and Jobs/Phases window, in the  6-6-1 Purchase Order 
window, from the Options menu, select Set Rules for Editing PO Vendors and Jobs/Phases .

You can select either or both of the following options:
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 l Allow vendor changes on existing purchase orders.

When you select this option, you can set options to restrict vendor changes to purchase orders for 
which:

 l No quantities have been received.

 l No invoices have been generated for the purchase order (so the Issued Date is blank).

 l No Accounts Payable invoice references the purchase order.

 l Allow job/phase changes on existing purchase orders. 

When you select this option, you can set options to restrict job and phase changes to purchase orders 
for which:

 l No quantities have been received.

 l No invoices have been generated for the purchase order (so the Issued Date is blank).

Note: These rules also apply to master purchase orders. Whatever remains on the regular purchase 
order affects how the rules are applied to the master.

 

Using Twilio as your email method
Instead of using SMTP for email, you can use your Twilio account to use emailing features in Sage 100 
Contractor.  

With earlier versions, you needed to configure your own SMTP connections. With SMTP requirements 
constantly changing in response to increasingly sophisticated security requirements, it could be a struggle to 
keep your email connection functioning.

Now, you simply enter your Twilio email account information in the 7-1 Company Information window, as 
follows:

 1. Select the Email and Fax Configuration tab.

 2. Enter Twilio Email Configuration settings as follows:

 a. For the Twilio Sender Identity, enter the email address you used to set up your Twilio account.

 b. For the Twilio SendGrid API Key, enter the API key code from your Twilio account.

 c. For the Default Sender Name, enter the default "friendly name" to use when sending emails.

14Sage 100 Contractor 2022 (SQL) Version 24.1 Release Notes Canada and U.S. Editions



 d. For the Default Reply-To Email, enter the default email address that your email recipients can 
reply to.

When you want to email a document, such as a 3-4-22 Client Service Statement:

 1. In the report window, click the email icon on the toolbar. 

 2. In the Email Distribution window:

 a. Enter the subject and email message.

 b. Select the contacts to which you're sending the message.

 c. Select email options.

 d. Enter the name of the attachment.

 e. Enter the email address from which you're sending the email.

 f. Click [Email Settings].

 3. In the Email Settings window:

 a. Select the Send email using the company's Twilio account option, and then accept or change the 
settings for:

 l The Friendly “From" Name. Enter the name that the recipient will see the email is from.

 l The Reply-to Email Address. Enter the email address the recipient can reply to. (The email 
address can be different from the email address for your Twilio account.)

 b. Click [Save].

 4. When you're ready to send the message, click [Send Now].

Your email is sent through your Twilio account to the recipient.

Note: When you send email using Twilio, Sage 100 Contractor sends a copy of the message to the 
Reply-to Email Address specified in the Email Settings window. 

Viewing user activity

Note: This report is available only if you sign in to Sage 100 Contractor with Administrator credentials 
and you have Payroll Admin rights.

You can use the new 7-7 User Activity Report to fortify your internal controls and to facilitate forensic audits. 
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Based on the history you keep for your company (typically, six months), the User Activity report is a 
comprehensive list of a selected user's accounting and payroll activity for a range of dates you specify. For 
example, if your company is concerned about fraud, you can quickly and easily get a report of all the entries an 
employee made in their last days of their employment without your having to build search queries for multiple 
windows. 

Note: The User Activity report relies on audit or history tables maintained for as long as you keep history. 
(You set options for keeping history in Database Administration.)

It shows transactions and records that were entered, modified, or deleted in the following areas of the program:

 l 1-General Ledger

 l 1-1 Checks/Bank Charges

 l 1-2 Deposits/Interest

 l 1-3 Journal Transactions

 l 1-4 Recurring Journal Transactions (posted recurring transactions are reported in a separate 
section)

 l 1-7 General Ledger Accounts

 l 3-Accounts Receivable

 l 3-2 Receivable Invoices/Credits

 l 3-3 Receipts

 l 3-5 Jobs (Contracts, Bid Items, and Phases)

 l 3-6 Clients (Contracts)

 l 3-10-1 T&M Billing Setup

 l 3-10-5 T&M Wage Rates

 l 3-10-6 T&M Equipment Rates

 l 3-11 Recurring Receivables

 l 4-Accounts Payable

 l 4-2 Payable Invoices/Credits

 l 4-3 Vendor Payments

 l 4-4 Vendors (Contracts, Certificates, Vendor Remit)
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 l 4-6 Recurring Payables

 l 4-7-3 Credit Card Receipts (no vendor entered)

 l 4-7-4 Credit Card Recurring Charges (posted recurring charges are reported in a separate 
section)

 l 4-7-6 Credit Card Payments

 l 5-Payroll

 l 5-2-1 Employees (Calculations, Licenses, Training)

 l 5-2-2 Payroll Records

 l 5-2-6 Post Payroll to GL

 l 5-3-1 Payroll Calculations

 l 5-3-2 Workers’ Compensation

 l 5-3-3 Employee Positions

 l 5-3-4 Paygroups (Benefits)

 l 5-3-5 Payroll Unions

 l 5-3-6 Local Payroll Tax

 l 5-6 Simple Time (but not 5-6-6 Time Entry Settings)

 l 8-Equipment Management

 l 8-3 Equipment

 l 8-4 Equipment Allocation

 l 8-5 Equipment Payments

 l 8-6 Equipment Depreciation

 l 11-Service Receivables

 l 11-2 Service Receivables (Invoices/Credits, Quotes, Work Orders, Routes, Contracts)

 l 12-Inventory

 l 12-2 Inventory Allocation

 l 12-3 Inventory Locations

 l 12-5 Inventory Audit

In each section of the report, you can select a change, and then click:
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 l [Go to Record] to drill down to view the record where the change was made.

 l [View Change] to open a History Details to view the changes for each field in the record.

To view user activity:

 1. From the Sage 100 Contractor System Menu, open 7-7 User Activity Report.

 2. Select criteria for the report:

 a. From the User list, select the user whose activity you want to view.

 b. Use the Date fields to specify the date range for the activity you want to inspect.

 c. (optional) Select the Show only sections with activity box.

 3. Click [Display Report].

Sage 100 Contractor displays a list of areas in the program where the selected user made changes. 
Each section shows the number of records that were entered, modified, or deleted.

 4. To view details, click the right arrow beside the type of change (entered, modified, or deleted) that you 
want to see.

Sage 100 Contractor displays a grid that lists the changes. 

 5. To view details about a specific change, select it on the grid, and then:

 l Click [Go to Record] to drill down to view the record where the change was made.

 l Click [View Change] to open a History Details to view the changes for each field in the record. 
Changed data is shown in bold type.

 6. When you've finished reviewing the changes in the report, you can either:

 l Clear the screen to start creating a new report by clicking [New Report], and then repeat steps 2 
through 5.

 l Click [Close].

Easily identify invoiced work orders on the Dispatch Board
You can now easily distinguish invoiced orders from other work orders on the 11-3 Dispatch Board by making 
the invoiced orders appear transparent and less obtrusive. Work orders that are not yet invoiced then stand out 
more clearly.
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To make invoiced work orders transparent:

 1. On the Dispatch Board, from the Settings menu, click Preferences. 

 2. In the Dispatch Board Preferences window, on the General tab,  select Show invoiced work orders as 
transparent. 

With this option selected, you can hover over an invoiced order  to see its details.  Details for orders that 
are not invoiced are displayed normally.

In this diagram, invoiced orders are bounded.
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Other improvements
Version 24.1 also includes the following improvements:

Choosing advanced options for saving attachments

Sage knows that the ability to attach documents to records is used extensively. Some attachments, particularly 
to employee records, may contain sensitive information, so it's important to save them securely! For example, 
attaching a garnishment order to an employee's record should not be saved with your company files, where 
anyone with access to the server can see it. 

In Database Administration, you can now select options on the new Advanced File Attachment Settings tab to 
determine where Sage 100 Contractor stores file attachments. 

For each type of record listed on the tab, you can choose whether users can copy attachments or link to 
external files (or both, if needed). The options you select can affect how secure the attachments will be. 

You can allow users to save attachments in the following ways: 

 l Copy attachments to your company data, where all users have access.

 l Link to files stored at other locations, where you can restrict access.

For more information about this new feature, see "Selecting File Attachment Settings," in the Database 
Administration help.

Enhancements for the U.S. Edition

Attributing wages and withholding tax for reciprocal state income tax

When you compute final payroll for employees who have a non-resident state tax withholding calculation, you 
can have Sage 100 Contractor calculate state tax withholding for wages the employee earned in the non-
resident state as if they earned it in their home state, and attribute it to their home state.

To assign withholding state to the employee's home state:

 1. In the employee record, inactivate the non-resident state income tax calculation (change the Active 
status to No or a blank).

 2. In the 5-2-3 Compute Payroll window, from the new Options menu, select Use Reciprocal State Income 
Tax Withholding Rules.
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Standardized Occupation Code (SOC) in employee records

In the 5-2-1 Employees window, on the Human Resources tab, there is a new SOC Code field. This field is for 
the employee's Standardized Occupational Classification code, which Washington state requires for quarterly 
reports beginning in the fourth quarter of 2022.
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Do you have a product idea you want to share with us?
We want to hear it! 

To suggest a product enhancement when you're working with Sage 100 Contractor:

 1. On the Sage 100 Contractor desktop, click the Home & Resources tab >  Submit Product Idea.

 2. Log in to the Sage 100 Contractor Ideas site (or sign up).

 3. Describe your idea. 

 4. (optional) Browse through others' suggestions, and vote for the ones you love!

Or visit https://www5.v1ideas.com/TheSageGroupplc/Sage100Contractor any time you're online!
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Fixes in Version 24.1

Fixes in Both Editions
Version 24.1 includes the following software fixes in both the U.S. and Canadian editions:

Accounts Payable fixes
 l In the 4-4 Vendors window, users who are subject to job security can create new vendor certificates for 

vendors that have existing certificates. 

Payroll fixes
 l When you compute payroll, Sage 100 Contractor now warns you when a federal, percentage-based 

payroll calculation has an incorrect default maximum. You can choose to continue to compute payroll 
despite the warning.

Note: In Quebec, you also receive a warning if the QPP, QPIP, or EI Quebec calculation has an 
incorrect default maximum.

 l 5-1-11 Certified Payroll reports now correctly include benefits that are set up using the 19 – Per Hour 
calculation method. 

 l In the  5-3-1 Payroll Calculations window, Subject To selections are no longer available for payroll 
calculations when the Calculation Type is set to 1 – Deduct from Employee for the following tax types: 

 l 10 - State Disability

 l 11 - Worker's Compensation

 l 13 - Local Income Tax

Service Receivables fixes
 l When the 11-3  Dispatch Board is in View Only mode, right-clicking a work order no longer lets you read 

the properties. 
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Estimating and Takeoff fixes
 l in the 9-5 Takeoffs window, you no longer receive an error when you copy and paste a value in the 

Quantity field. 

Project Management fixes
 l In the 6-1-13 Home Builder Reports, you do not have to select criteria when you run the 6-1-13-26 

Committed Budget/Job Cost Variance ~Jobs by Cost Code report. 

 l The 6-1-4-41 Job Cost Summary ~ by Phase report prints correct results when you select the Over 
Budget Only option. 

 l In the 6-6-1 Purchase Orders window, random characters are not added to the order number purchase 
orders if you accidentally strike one of the keys above Enter key.

 l You can drill down to the 6-7-1 Subcontracts record from subcontract lines in reports that offer a query to 
subcontracts. 

 

Miscellaneous fixes
 l If you close Sage 100 Contractor when the main window is maximized, the next time you open the 

program, the window is maximized and properly positioned. 

 l The cost code lookup window displays cost codes from the budget and any change orders for the job.

 l When you run a query from a shortcut on your desktop, the drilldown button is available for the query 
grid. 

 l We refreshed the appearance of Sage 100 Contractor  with our new Sage logo throughout the program. 

 l When you start Sage 100 Contractor using the Run as Administrator command in Windows, some 
program functions (such as the calendar) don't work properly. 

You now receive a warning when you start the program using Run as Administrator so that you can 
change your mind or proceed with the knowledge that functionality could be limited because of this 
choice. 

 l The data control field provides limited field property options (accessed using the F7 key) consistent with 
the type of record to ensure that you do not select a default value or security that interferes with data 
selection in the record you are working with and in other windows. Sage 100 Contractor windows.   

 l In attachment windows, links to web pages now open in your default browser. 
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 l When you run a report that has a {variable[S]} field in it, you can close the {variable[S]} dialog box 
using the X as well as the Cancel button. 

Fixes for the U.S. Edition
The following issue was fixed specifically for the U.S. Edition of Sage 100 Contractor:

 l In the 5-2-1 Employees window, Sage 100 Contractor warns you if you try to save a new record without 
indicating a marital status. (Sage 100 Contractor cannot calculate federal tax for an employee without a 
marital or filing status.) 

Note:  

 l If a W-4 created before 2020 is still in effect for the employee, you need to enter the marital 
status on the Federal Income Tax line on the Calculations tab.

 l For newer W-4s, you enter a Filing Status on the W-4 Information tab.

 l The 5-2-5 Direct Deposit File Manager can now create ACH files for banks, such as the Chase Bank, 
that require a bank-supplied company ID in the batch header.

You enter the ID in the 7-1 Company Information window on the Payroll Direct Deposit Setup and 
Vendor ACH Payment Setup tabs.

Fixes for the Canadian Edition
The following issues were fixed specifically for the Canadian edition:

 l In the 9-5 Takeoffs window, when you select the option to update minimum quantities in a takeoff, the 
program now correctly applies Canadian sales taxes. 

 l You can schedule an appointment properly in the calendar. 

 l On the Help menu, the About window now shows the correct date of the 2022.1 payroll tax file release, 
which is 01/01/2022. 
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API for third-party developer products

This release provides the following fixes for the API:

 l The API properly calculates takeoffs even if an Assembly# exceeds 2147483647. 

 l The API can now calculate minimum quantities for takeoffs. 
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Summary of enhancements in earlier 
versions of Sage 100 Contractor (SQL)

Earlier versions of Sage 100 Contractor (SQL) provided a wide variety of new features, including many 
enhancements that our customers have requested.

The following table is a list of  the most significant features introduced in earlier versions, details of which you 
can read about in the Release Notes for the respective version. 

 
Enhancements by version

U.S. 
Only

Canada Only  
API 

Version 23.3 enhancements 
(For details, see the v23.3 Release Notes)

 l New Aatrix 1099-NEC Forms x   

Version 23.2 enhancements 
(For details, see the v23.2 Release Notes)

Many customer-requested enhancements for both editions, 
including (and this is only a partial list):

   

 l A new window for printing deposit slips    

 l Ability to add custom email messages for direct deposits    

 l Ability to change jobs on computed payroll records    

 l Better sorting on grids    

Version 23.1 enhancements 
(For details, see the v23.1 Release Notes)

Simple Time Entry    

Sage Time mobile app    

Easily Allocate Inventory-Related Use Taxes x   

Summary of enhancements by version
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Enhancements by version

U.S. 
Only

Canada Only  
API 

Version 22.4 enhancements 
(For details, see the v22.4 Release Notes)

Enhancements for 2020 1099 Reporting x   

Enhancements for 2020 ACA Reporting x   

Support for new T4 requirements related to COVID reporting  x  

Version 22.3 enhancements 
(For details, see the v22.3 Release Notes)

Reports on stored personal information    

Support for new W-4 forms x   

Support for COVID-19 related absences and wages    

Version 22.2 enhancements 
(For details, see the v22.2 Release Notes)

Integration with eTakeoff Dimension    

Refinements for 'Use Taxes' x   

Support for Equal Employment Opportunity Commission (EEOC) 
Reports

x   

Version 22.1 enhancements 
(For details, see the v22.1 Release Notes)

Command-level security for many options and Post commands    

Ability to save final reconciliations for later access    

Ability to transfer amounts between bank accounts    

Warning when posting an AP invoice with no subcontract    

Ability to view Sage messages in Sage 100 Contractor    

Job templates to use and reuse in takeoff    

Ability to report on use taxes x   
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Enhancements by version

U.S. 
Only

Canada Only  
API 

New payroll type for retiring allowances  x  

Several additional customer-requested enhancements    

Version 21.3 enhancements 
(For details, see the v21.3 Release Notes)

Some minor enhancements plus U.S. tax updates.    

Version 21.2 enhancements 
(For details, see the v21.2  Release Notes)

Ability to merge client records    

Ability to merge vendor records    

Ability to include a record's attachments when you email forms    

Ability to email statements to jobs and clients    

Ability to record external vendor payments    

Ability to specify a secondary backup location    

Ability to track vendor certificates by job    

More ways to list vendor invoices to pay    

Version 21.1 enhancements 
(For details, see the v21.1  Release Notes)

Bank feeds    

Ability to email direct deposit stubs at a later date    

Enhanced cost type validation    

Enhanced Search (Find) in the 9-5 Jobs window    

Ability to move company to a new drive    

Ability to view an employee's pay raise history    

Ability to create timecards for individuals in Daily Payroll    

Ability to create payroll records for salaried employees    
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Enhancements by version

U.S. 
Only

Canada Only  
API 

Ability to restrict exclusive access for specific non-administrative 
users

   

Version 20.7 enhancements 
(For details, see the v20.7 Release Notes)

Ability to print a new 5-1-8-86  Vacation Hours Earned and Used 
Report

x   

Version 20.6 enhancements 
(For details, see the v20.6 Release Notes)

New Server Management Tools    

Ability to set records "Inactive"    

More efficient login    

Ability to replace Cost Codes, Vendors, Tasks, or Inventory 
Locations in a takeoff

   

New Combined Accounts Receivable and Service Receivables 
aging reports

   

Ability to print Accounts Receivable Aging Reports by Invoice 
Date

   

Ability to print Accounts Payable Aging Reports by Invoice Date    

Ability to print Service Invoice Aging Reports by Invoice Date    

New banking categories you can assign to bank-related journal 
transactions

   

Improved vacation tracking x   

Version 20.5 enhancements 
(For details, see the v20.5 Release Notes)

Ability to use new custom fields in most windows    

Ability to tag rows for followup in the 9‐5 Takeoffs grid    

Audit Information is available in Advanced Company Settings    
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Enhancements by version

U.S. 
Only

Canada Only  
API 

Numeric fields provide automatic calculation    

Easier access to user subfolders in workgroups    

Ability to correct the period of a posted payroll transaction    

Ability to skip automatic calculation during takeoff    

Ability to filter cost codes by Job and Phase in lookup windows    

Ability to filter unassigned work orders on the Dispatch Board    

A new option for saving and selecting company-specific custom 
reports and forms

   

Ability to use a new standard calendar to select dates    

Support for Microsoft SQL Server 2016 and Windows 2016 
Server

   

Ability to copy user process maps    

Ability to use high contrast display settings for Windows 10    

Ability to print a new Payroll Check Register 5‐1‐2‐31 by check 
date

   

3‐7 Progress Billing and 12‐2 Inventory Allocation allow 5,000 
rows

   

Tax and Workers' Comp rates in 4‐4 and 4‐2 use 4 decimal places x   

Workers' Comp Reports 21, 86, and 96 show Overtime Hours x   

Version 20.4 enhancements
(For details, see the v20.4 Release Notes)

Ability to copy external files to other users    

New option to approve the removal of employee records    

Version 20.3 enhancements
(For details, see the v20.3 Release Notes)

Ability to view change history in records    
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Enhancements by version

U.S. 
Only

Canada Only  
API 

New option for closing purchase orders automatically    

Support for Paya Exchange Desktop 2.0    

Support for customized tables and views    

Ability to use a new window to add client service locations quickly    

Effective rate shown for Sales Tax Districts (U.S. only) x   

API supports adding and removing attachments   x

API enforces locks   x

Schema change for Global Variables   x

Version 20.2 enhancements 
(For details, see the v20.2 Release Notes)

Simplified schedules lookup    

QueryJobCost (API Enhancement)   x

SetExclusive (API Enhancement)   x

Version 20.1 enhancements 
(For details, see the v20.1 Release Notes)

   

More versatile lookup windows    

Unique Payroll record numbers    
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Known issues and comments

The following sections describe known issues and problems in Sage 100 Contractor Version 24.1.

Compliance and Payroll Checks

Important! The sample check forms that come with Sage 100 Contractor may not be fully compliant with 
all federal, state, and local laws, and other requirements that can differ from one jurisdiction to another.  It 
is your responsibility to familiarize yourself with all applicable laws and requirements, and to modify 
check forms as needed to ensure compliance. For information about customizing check forms, see 13-5 
Form/Report Page Design in the Sage 100 Contractor help, or contact your Sage business partner for 
assistance.

Internet access required for Sage 100 Contractor
Sage 100 Contractor features, such as printing or efiling  tax forms, submitting enhancement requests, 
accessing Help, or downloading periodic product or tax updates all require Internet access. 

To take advantage of these features, ensure that any workstation or server that Sage 100 Contractor is 
installed on has access to the Internet. 

During installation of Sage 100 Contractor, the computer serving as the Sage license server must be able to 
connect to the Internet to obtain licenses. Once installation is complete, you can check out license uses for 
each computer where   Sage 100 Contractor is installed, then disconnect the Sage license server from the 
Internet. 

Configuring anti-virus software and third-party firewalls
During installation of the Sage 100 Contractor Hosting Framework, the Windows Firewall is configured 
automatically to enable the Sage 100 Contractor Hosting Framework to act as a TCP server. If you use some 
other firewall, you may need to manually adjust some settings in the firewall in order to ensure proper 
operation.

You can use the following procedure to configure the Windows Firewall manually to allow the Sage 100 
Contractor Hosting Framework to communicate with other computers. Use it as the basis for manually 
configuring other third-party firewall products.
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To configure the Windows Firewall:

 1. Click Start > All apps > Control Panel > System and Security.

 2. Open Windows Firewall, and then select Allow a program or feature through Windows Firewall.

 3. Select Sage 100 Contractor Hosting Framework on the list, if it is not selected.

Note: By default, the exception is set to allow access by any computer on the network. You can refine 
this setting by selecting the Change Scope button. Be aware that restricting the scope incorrectly can 
cause the computer to be unable to connect with some or all of the other machines on the network.

Files to exclude when manually configuring your firewall for Windows 8.1 Professional and Windows 
10 Professional 32-bit 

 l C:\ProgramData\Sage\Sage 100 Contractor SQL

 l C:\Program Files\Sage\Sage 100 Contractor SQL

 l C:\ProgramData\Aatrix Software 

 l C:\Program Files\Aatrix Software 

 l C:\%LocalAppData%\Sage\Sage 100 Contractor SQL

 l Network location of Sage 100 Contractor SQLdata. (If you install SQL Server Express using Database 
Administration, this location is C:\Sage100Con\Company\.)

Files to exclude when manually configuring your firewall for Windows 8.1 Professional and Windows 
10 Professional 64-bit

 l C:\ProgramData\Sage\Sage 100 Contractor SQL

 l C:\Program Files (x86)\Sage\Sage 100 Contractor SQL

 l C:\Program Files (x86)\Aatrix Software 

 l C:\ProgramData\Aatrix Software 

 l C:\%LocalAppData%\Sage\Sage 100 Contractor SQL

 l Network location of Sage 100 Contractor data. (If you install SQL Server Express using Database 
Administration, this location is C:\Sage100Con\Company\.)

Software and hardware required to support Microsoft SQL 
Server
Version 24.1 requires an instance of Microsoft SQL Server. You can download and use Microsoft SQL Express 
at no charge, or you can use the full version of Microsoft SQL Server. You can even start using Microsoft SQL 
Express, and upgrade to the full version of Microsoft SQL Server later, if necessary.
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When you first open the new Database Administration tool, the program tries to configure an instance of 
Microsoft SQL Server with optimal settings for Sage 100 Contractor for you. If you do not already have an 
instance of Microsoft SQL Server, you can let the Database Administration tool download, install, and 
configure Microsoft SQL Express for you.

Refer to Knowledgebase article 115593 for detailed information about supported operating systems and 
software, and for minimum hardware requirements.

Installation of Microsoft SQL Server on a domain controller is 
not recommended
Microsoft recommends against installing SQL Server on a domain controller, and does not support SQL Server 
on a read-only domain controller should you encounter any problems with this configuration. 

Because you must install Database Administration on the same machine as SQL Server, you should not install 
Database Administration on a domain controller. To guard against inadvertent installation on a domain 
controller and the potential for irrecoverable data losses, you will receive a warning if you attempt to install 
Database Administration on a machine used as a domain controller .

For more information, see the Microsoft Knowledgebase article https://support.microsoft.com/en-
us/kb/2032911.

About .NET Framework

.NET 4.8 Framework is required

If Microsoft .NET 4.8 Framework is not already installed, it will be installed automatically when you install Sage 
100 Contractor. Installation of .NET 4.8 Framework alone may take up to 20 minutes per computer.

Make sure that both your client and server computers meet the minimum requirements for installing both Sage 
100 Contractor software and .NET 4.8 Framework. 

Note: If Sage 100 Contractor requires an installation of .NET 4.8 Framework, the Sage 100 Contractor 
installation process may continue automatically after the .NET Framework installation is completed. If 
you are prompted to restart your computer after the .NET Framework installation, you must do so to 
continue the Sage 100 Contractor installation. 

.NET 3.5 is also required

In some situations, you may need to turn on .NET 3.5 manually by selecting the .NET 3.5 checkbox in the 
Windows Features dialog box. For more information, see Knowledgebase article ID 68381, available at 
https://support.na.sage.com/selfservice/viewdocument.do?externalId=68381.
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Turning on Microsoft .NET 3.5

Microsoft .NET 3.5 must be available and enabled prior to installing Sage 100 Contractor. 

If you attempt to install Sage 100 Contractor  without .NET 3.5 installed, you receive the following message 
during the licensing install: 

“Sage.CRE.HostingFramework.Service v3.2 has stopped working.” 

When you click [OK], the installation continues, but the services have not been installed so Sage 100 
Contractor cannot open. The Sage.CRE.HostingFramework Service does not install unless .NET 3.5 is 
installed. If you receive the above message during installation, install .NET Framework 3.5., and then reinstall 
Sage 100 Contractor.

The following instructions are for Windows Server 2008 R2.

To verify that .NET 3.5 is installed:

 1. Click the Start button in the lower left corner of the display.

 2. Highlight Administrative Tools and select Server Manager.

 3. In the Server Manager interface, click Features to display all the installed Features in the right-hand 
pane.  Verify that .NET Framework 3.5.1 is listed.

To enable .NET 3.5:

 1. In the Server Manager interface, select Add Features to display a list of possible features.

 2. In the Select Features interface, expand .NET Framework 3.5.1 Features.

 3. Once you expand .NET Framework 3.5.1 Features, you will see two checkboxes.  Check the box next to 
.NET Framework 3.5.1 and click Next.

 4. In the Confirm Installation Selections interface, review the selections and then click [Install].

 5. Allow the installation process to complete and then click [Close].

Note: Enabling .NET Framework 3.5.1 may require a reboot. 

About network configuration and TCP Remoting Channel
Sage 100 Contractor uses the TCP Remoting Channel, a Microsoft .NET Framework component, to enable 
communication among computers on a network. By default, Sage 100 Contractor uses the TCP starting port 
48760. Certain configurations can potentially disable the communication: 
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 l You must enable file sharing on your computers. To enable file sharing, follow the instructions in the 
Windows  Help.

 l TCP communication requires the selection of port numbers that are not in use by other processes on the 
local computer. 

 l Software firewalls running on the local computer can be configured to block processes from opening 
TCP ports, which will prevent communication through the TCP Remoting Channel. 

PCI DSS Compliance
PCI DSS stands for Payment Card Industry Data Security Standard. It was developed by the major credit card 
companies as a guideline to help organizations that process card payments to prevent credit card fraud, 
cracking, and other security weaknesses and threats. 

A company processing, storing, or transmitting payment card data must be PCI-compliant or risk losing its 
ability to process credit card payments and being audited and/or fined. (For more information about PCI 
standards, see https://www.pcisecuritystandards.org/.)

Sage 100 Contractor payment processing works exclusively with Paya to enable merchants to seamlessly 
process check and credit card transactions directly in Sage 100 Contractor. The payment processing program 
uses Paya Exchange, a secure payment-processing application, to connect to Paya and process check and 
credit card transactions.

Integrating your financial and operations system with Paya lets you process check and credit card transactions 
without storing your customers’ sensitive card information in your database. Paya Exchange transmits check 
and credit card details through a secure connection to Paya, where they are stored in a PCI-compliant vault, 
protecting your from exposure to non-compliance penalties and credit card fraud.

Caution! To avoid non-compliance with PCI standards, do not store credit card information in Sage 100 
Contractor. Such storage creates unnecessary risk for your business and your customers.

Tax Forms and eFiling by Aatrix configuration requirements
Tax Forms and eFiling by Aatrix requires an Internet connection for two reasons:

 l For updating forms and executable files.

 l For electronic filing (eFiling) of the forms.

If you experience an Internet connection problem, it may be due to problems communicating through an 
Internet firewall. Firewalls need to have access allowed through specific ports:

 l The Tax Forms and eFiling Updater uses standard SSL/HTTP port 80 to access the site 
http://updates.aatrix.com.

 l The eFiling component uses secure HTTPS on port 443 to access the site https://efile.aatrix.com.
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By allowing access to aatrix.com, you allow both updates and eFiling. Occasionally, restrictions are tighter and 
only allow access to these ports by specific programs. Tax Forms and eFiling uses the following programs to 
access the Internet.

For updating using http on port 80 to http://updates.aatrix.com:

 l aatrixforms.exe

 l updater.exe

 l updater2.exe

For eFiling using secure http on port 443 to https://efile.aatrix.com:

 l builder.exe

 l viewer.exe

Use Adobe Reader Version 8.1.3 or later for faxing
Customers have reported problems faxing from Sage 100 Contractor with versions of Adobe Reader earlier 
than 8.1.3. Adobe Reader Version 8.1.3 and later support faxing from Windows and from Sage 100 Contractor.

Important! To fax from Sage 100 Contractor, the Windows Fax Service component must be installed with 
your Windows operating system. For more information about installing the Windows Fax Service 
component, see the Sage 100 Contractor Help topic, “Installing the Windows Fax Service component.”

Configuring Windows regional and short date format

To specify regional formats for Windows:

 1. Click the [Start] button, point to Control Panel, then click Clock, Language, and Region .

 2. Click Region and Language.

 3. On the Formats tab, select the format for your country.

 4. Under Date and time formats, from the Short date format drop-down list, select  the format used for your 
country.

 5. Click [OK].

 6. Close the Clock, Language, and Region window.
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Windows "Sleep Mode" prevents computers from obtaining a 
license use
If the computer you are using as a license server goes into sleep mode, other computers on the network 
cannot obtain a license. 

To avoid this possibility, set Sleep Mode on your license server computer to Never.

To set the Sleep Mode to “Never”:

 1. In Windows 8.1 Professional, Windows 10, or Server 2012 Standard, click Start > All apps > Control 
Panel > System and Security > Power Options. 

In Windows 7, click Start > Control Panel > System and Security > Power Options

 2. Select Change when computer sleeps. 

 3. From the Put computer to sleep list, select Never. 

Sage licensing (Sage 100 Contractor Hosting Framework) 
cannot auto-start on Windows 8.1
The Sage licensing service (Sage 100 Contractor Hosting Framework) cannot auto-start on computers running 
the Windows 8.1 Professional or Windows 8.1 Enterprise operating systems. If the service stops, the program 
displays a message advising you to take further action to resolve this issue.
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